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Summary:

This excerpt is a tutorial guiding a new user of BibDesk step by step through the typical use of BibDesk.
Although the tutorial is targeted at members of the Systems Ecology Group of ETH Zurich, Switzerland, it is
of general interest, since it describes typical working steps using BibDesk. Simply skip over any sections that
are too specific. After the tutorial this excerpt does also describe in detail how to customize BibDesk, which is
not only of particular interest to members of the systems ecology group, but may also be of interest to other
BibDesk users, notably since no official BibDesk tutorial exists. The excerpt also contains some possibly useful
tables relating BibTeX/BibDesk and EndNote reference types and fields together with the FileMaker based
data base for the members of the Systems Ecology group at ETH Zurich.
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1.9.2 USING BIBDESK  -  A SHORT TUTORIAL 

Once customized as described in previous section try it out. Launch LiteratureMY, select 
some records and choose FileMaker script «Export to BibDesk». BibDesk is launched and 
your records should appear in a new window. In case BibDesk was already running and had 
some bib-file open, the records will be imported and are shown highlighted within the 
frontmost window similar to this: 

 

Secondly try to acquire some references from ISI Web of Science by choosing menu 
command “Searches -> Web of Science SCI”: 
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Then type  

AU=Fischlin AND TI=forest? 

into the appearing search field69 and press return you should get something similar to this: 

 

Note I have customized the columns display by using the popup menu at the right corner and 
inserting the field Doi (using Add Other…) into the default display and having rearranged the 
order as shown here. This offers the advantage that you can immediately jump to a paper via 
its doi. Try it out and you should get something similar to this: 

                                                 
69 Details on how to encode such searches can be found in BibDesk’s help system (topic «Searching External 
Databases») and at http://images.isiknowledge.com/WOK46/help/WOS/h advanced fieldtags.html  



Latest Additions Literature September 4, 2009 

39 

 

You may decide you are not really interested in the Fuhrer et al. (2006) paper but wish to 
keep Fischlin & Gyalistras (1997) (assuming this record is really missing in your 
LiteratureMY). Accomplish the import by clicking onto the little import button in the leftmost 
column, i.e. . Then leave the searching in ISI WOS Group and go back to the group 
Library by clicking on the yellow BibDesk icon at the top. The result should look similar to 
this: 
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Note, a new main key (cite key) has automatically been assigned70 and the red cite-key 
symbol , which indicated a missing main key, is gone. You can now also access the ISI 
WOS web site clicking onto the top right thumbnail in the pane to the right side of the 
window and using there the button  

 

It gets you to the JSTOR repository of the paper  

 

                                                 
70 You may easily create a new main key by simply choosing menu command “Publication -> Generate Cite 
Key” (Cmd-K). However, you should refrain from wasting codes and refrain from using this command unless 
this becomes a necessity to avoid conflicting cite keys. 
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where you can download the pdf. You could download it to any location on your disk, but I 
recommend to open it in Adobe Reader by a control click71, once the pdf shows up in the 
browser window. The advantage of having it opened in Adobe Reader is that you can simply 
drag and drop the pdf from the title bar of the Reader’s window to the right side pane of 
BibDesk (next figure, left). This should immediately link the pdf with your record, rename it 
and move it to the proper location on your disk (assuming you have set the preferences as 
described above) and a corresponding thumbnail for the pdf should appear in the right side 
pane of your BibDesk  document window (next figure, right).  

                     

You are now done if your preference settings “File papers automatically” is checked, because 
the pdf was renamed to ‘Fi160.pdf” and filed to the wanted location where you keep your 
pdf’s. Otherwise choose menu command “Publication -> AutoFile Linked Files…” (Cmd-
Shift-K) and the file is also renamed and permanently stored at the wanted location. 
BibDesk’s window looks now similar to this: 

 

                                                 
71 This convenient method is NOT available if you have not prevented the intrusive Adobe Reader plug-in be 
used in your browsers. I recommend to always turn this feature off, by setting the internet preferences in Adobe 
Reader (or Acrobat) such that check box “Display PDF in browser using: Adobe …” is not checked. Then a 
browser such as safari uses the internal Mac OS X capabilities to display pdf’s, which is more efficient and more 
convenient than Adobe’s plug-ins. 
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Let’s do something more technical, i.e. editing the record. First you may wish to add some 
comments. Hit return or double-click the record to open it for editing. See, the standard 
BibTEX  field note is missing. Add it by clicking onto the + in the lower left corner and enter 
the field’s name similar to this: 

 

And then enter your comments 

 

While we are at it, let’s also copy the stable URL provided by JSTOR into the new record, 
since that URL can not directly be dragged and dropped from the browser to BibDesk’s right 
side pane. We can create another new field, i.e. field Url for that in the same manner we have 
created the standard BibTEX  field note. Then copy-paste the data from JSTOR’s web site to 
your record: 

 

Save your data by choosing command “File -> Save” (Cmd-S). Notice the little DOI symbol 
to the right of the new field Url?  

 

It allows you to conveniently jump to this URL. We are done and can close the editing 
window.  

However, the nifty jump button was available only while editing the record! Of course we 
could add the column Url to the standard list view as we have done for the DOI in order to be 
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able to jump to the just added URL. However, there is a better technique available and the 
field Url should be used as little as possible: We issue the menu command “Data base -> 
Convert File and URL Fields” and click on the button Convert 

                                    

This will let appear the added URL magically in form of an additional thumbnail on the right side 
pane, which should now look similar to the above. This conversion makes the just added URL 
available for jumping. This conversion is therefore always recommended, in particular before 
transferring records back to LiteratureMY. Note, if you forget to convert, you may risk losing some 
information, perhaps even links to your pdf’s.72 

Finally, lets transfer the just acquired record back to LiteratureMY. How to find newly 
acquired records in a large bibliography? Simply type “fromBibDesk” into the search field 
you find at the top right corner of BibDesk ’s window 

 

                                                 
72 Note, with the recommended settings (see previous section «Customizing BibDesk ») this conversion will also 
convert and remove any so-called file URLs (starting with file://localhost…) stored in a field Local-Url and 
make them also appear on the right side pane. Such local file URLs may have resulted from importing records. 
However note, this is a one-way avenue, since the exporting of the content of the fields Local-Url (as well as 
Url) is no longer supported. BibDesk  developers plan to deprecate the use of local file URLs and favor the use 
of aliases instead, which are always shown in the right side pane and are listed under the heading Local Files. 
The advantage being not only that file links are shown in the right side pane, but also that you can even move 
such files on your disk, yet the links do not break. Similarly for URLs pointing at web sites. Once converted they 
are listed under heading Remote URLs and are also shown on the right side pane. Therefore, remember, it is in 
general safer to convert File and URL Fields for all records, before transferring records back to LiteratureMY! If 
it doesn’t help, it shouldn’t hurt either. 
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and all records that were acquired from within BibDesk are shown. Note, each time you 
generate a new cite key for a record, the phrase “fromBibDesk” is added to a special field 
Custom2:  

 

This marking of records is of a temporary nature and allows you always to find those records, 
that have not yet been transferred back to LiteratureMY. Once you have completed a transfer 
to LiteratureMY and come back with it to BibDesk, this mark will be gone. 

To actually accomplish the transfer, simply switch to LiteratureMY and choose FileMaker 
script «Import from BibDesk». Always ensure that the wanted records are currently selected 
in BibDesk or the entire library will be transferred. The wanted data are first sent to a scratch 
EndNote bibliography (file ‘refs.enl’ in your Literature work folder), which should only 
quickly appear and then imported into LiteratureMY (see also Appendix A2 «Transferring 
records between EndNote and FileMaker (LiteratureMY)»). You should now see in 
LiteratureMY something similar to this: 

 

You are done and best is to delete any records from the BibDesk file in which they were acquired once 
the transfer to LiteratureMY is completed. It is in general recommended to consider the BibDesk file in 
which you acquire records merely as a scratch working area, reserved for acquiring records. Actual 
use of records is best done in separate BibDesk files, that are dedicated to particular projects such as 
writing a paper or a thesis. Remember, BibDesk files are actually regular BibTEX files. Yet, such 
project specific bibliography files are useful in any case, i.e. regardless whether you write with 
LaTEX or Word (given you performed also the optional customizations relevant for temporary 
EndNote citations, see above section «Customizing BibDesk»). 

Some final comments on caveats with URLs: LiteratureMY maintains only a single entry in the field 
URL and through the transfer only one entry survives in that field. This is the one with the highest 
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relevance, typically the one shown at the top of the right side pane of BibDesk’s windows. However, 
this does not mean only one thumbnail survives the transfer. In fact, the transfer is very sophisticated 
and tries to make good use of all information contained in the right side pane. The following holds: 

• Pdf links are maintained and properly transferred73 
• DOI URLs are discarded after having extracted the DOI and stored it into the field 

DOI74 
• If no actual DOI is defined for the work, the field DOI may also hold an URL of the 

form “http://…”. Typically this is the URL, which was at the top of BibDesk’s right 
side pane (priorities go from top to bottom). 

• Similarly, ISI WOS record numbers are shown as a <Goto ISI> Link, given such a 
link does not conflict with an actual URL that starts with “http://…”.75 

In above example, entering the permanent JSTOR link into the field URL will give that entry 
priority and that’s also what you see in above example. Should there also have been an actual 
DOI URL in the right side pane of BibDesk’s’ window, i.e. one starting with 
“http://dx.doi.org/…”, that URL would be gone. But don’t’ worry, its actual DOI would have 
been preserved and properly stored in the field DOI. 

Data transfers are conservative and in general no data should get lost during transfers. 
However, there is one notable exception: End of lines within the field Comments do not 
survive. As of this writing, once they arrive in BibDesk’s field note, all data are wrapped and 
filled into the field. Incidentally, this is fortunately not the case with the field abstract, which 
preserves paragraph structuring. 

If you frequently transfer records back and forth between BibDesk and LiteratureMY I 
recommend to define keyboard shortcuts in the System Preferences pane Keyboard & Mouse 
for FileMaker, following the technique as described in section «New helper scripts». I use 
Control-6 (for export) and Control-7 (for import) in analogy to Command-6 (for export to 
EndNote) and Command-7 (for import from EndNote) as provided by default for the 
FileMaker  transfer scripts in LiteratureMY. 

1.9.3 TRANSFERRING RECORDS INTO AND FROM BIBDESK  

Transfers of records are possible among all three main components of our system, i.e. 
LiteratureMY (FileMaker), EndNoteMY (EndNote), and BibTEX (BibDesk). The transfer of 
records between LiteratureMY and BibDesk is described at the end of the section «Using 
BibDesk - a short tutorial». This covers even the transfer of records from BibDesk to EndNote, 
since the transfer from BibDesk to LiteratureMY takes place via EndNote. The only missing 
transfer not yet covered is that from EndNote to BibDesk. This transfer is also possible, albeit 
some restrictions may apply (see also Appendix «A3 Transferring records among applications 
– possibilities and restrictions»). To accomplish this transfer, simply select the records in 

                                                 
73 LiteratureMY may actually ask you to specify the folder where you keep your pdf’s before initiating a transfer 
to ensure that this information is always also properly transferred. 
74 This works also for URLs that have the DOI hidden somewhere in them, given the keyword KeyUT=’ could 
be found in an URL that starts with “http://gateway.isiknowledge.com/…” 
75 unless that URL should be redundant (e.g. with the one stored in field DOI) then the <Goto ISI> Link will be 
favored. 
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EndNote, choose as output style the provided style ~BibTeX Export and choose menu 
command “Edit -> Copy Formatted” (Cmd-K). Then paste the clipboard into any BibDesk 
data base. In case of difficulties, please consult Appendix «A3 Transferring records among 
applications – possibilities and restrictions». 
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1.9. Using BibDesk  

BibDesk58 is a great application that allows you not only to manage BibTEX files, but also to 
acquire records from ISI Web of Science and many other data bases such as NEBIS provided 
by the main library at ETH Zurich59. It is even possible to automatically assign a final main 
key (SECode, cite key) while acquiring new records within BibDesk. This is important, since 
BibDesk offers also to immediately link pdf’s to such newly acquired records and to store 
pfs’s conveniently in your pdf folder. All very powerful and very convenient in contrast to all 
other techniques offered by our system. Once acquired, the new records can be safely 
transferred to LiteratureMY for final storage.  

However, there are caveats associated with this technique, notably there is the risk of main 
key conflicts if both techniques of acquiring records should be used in parallel or in any other 
uncoordinated manner. However, if you adhere to a few rules such risks can be avoided and a 
smooth working flow can be achieved. These rules apply (details provided below): 

1) Customize BibDesk once to set its preferences to apply the same rules as employed 
by your LiteratureMY system. Following preferences need to be modified from the 
factory settings: 

- Automatic generation of Cite Key with a special hook script Did_cite_key 
- Automatic conversion of local files and automatic filing by BibDesk 

2) Install some utilities, notably AppleScripts such as DumpCodesMY, that allow to 
conveniently coordinate your work between BibDesk and LiteratureMY 

Once properly setup you need to stick to following rules of usage: 

1) Either acquire new records in BibDesk or LiteratureMY, but never in both at the 
same time. 

2) Always before you start using BibDesk to acquire records run utility 
DumpCodesMY. The latest main keys as used by LiteratureMY will be made 
available to BibDesk 60. 

3) Always before you resume using LiteratureMY to acquire new records transfer all 
the records you have acquired in BibDesk back to LiteratureMY. This will ensure 
CodesMY is properly updated and LiteratureMY learns about the main keys you used 
in BibDesk. 

                                                 
58 A great open source application available from http://bibdesk.sourceforge.net/ 
59 Requires the installation of a little BibDesk Search file (extension ‘.bdsksearch’). Many data base services 
offer now such search files. One for NEBIS, named ‘NEBIS-zoom.bdsksearch’, is also distributed with the 
package EndNote SE Add Ons… (disk image EndNote SE Add Ons….dgm). You need to install it only once in 
BibDesk (menu Searches) and should then be able to conveniently search in NEBIS from within BibDesk. 
60 BibDesk uses actually a small text file CodesBibDeskAF storing similar information as CodesMY does. Make 
sure you well preserve this file. To coordinate the main key assignment, an additional auxiliary file will be 
generated by AppleScript DumpCodesMY named ‘DumpOfCodesAF’. BibDesk will make sure that correct keys 
are assigned if DumpOfCodesAF’s content is uptodate and properly reflects the content of CodesMY. 
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1.9.1 CUSTOMIZING BIBDESK  

The main key (SECode, SysEcolCode) or Cite Key need to be globally unique. This is 
accomplished by generating a unique cite key while acquiring records. BibDesk supports the 
automatic generation of such a main key, but requires following customization to conform to 
the rules of the LiteratureMY system: 

1) Set your Cite Key preferences in BibDesk exactly to this61:   

 
3) Set your Script Hook preferences in BibDesk to this62:  

 
 Note this step requires you have copied the script ‘Did_cite_key’ in the location 

given above63. Note, above settings assume you have installed script ‘Did_autofile’ 

                                                 
61The Format String specifies that the main key is to be constructed from the first 2 characters from the first 
author (%a1002) and then a unique number consisting of 3 digits (%n3) 
62The Format String specifies that the main key is to be constructed from the first 2 characters from the first 
author (%a1002) and then a unique number consisting of 3 digits (%n3) 
63 Provided on distribution of package EndNote SE Add Ons… 
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as a folder action script for your pdf’ depository folder (previously also called 
“pdfwar - Store In Letter Folder”). If that is not the case, then you should also install 
that very same script as a second hook for “Did Auto File” as this and make sure you 
have any possibly previously installed folder action script “pdfwar - Store In Letter 
Folder” disabled: 

 
 Try it out, which variant works better for you. This second one is recommended 

when you work mostly with BibDesk, the first is recommended if you often drop 
manually some pdf’s onto your depository folder and you wish those being filed 
automatically within the proper subfolders. Having both active at the same time is 
not recommended and may lead to unpredictable results.  

4) Copy the AppleScript DumpCodesMY to your system and run it at least once. Make 
sure you keep DumpCodesMY handy for any subsequent use. Upon successful 
completion you should have file DumpOfCodesMY64 in your literature work folder65. 

Now you should be ready to acquire new records from within BibDesk and assign them 
automatically a new, final main key (SECode or cite key). Note, this technique offers not only 
the advantage of generating conveniently a main key unique within the current BibDesk file, 
but also across several BibDesk files you may be using, may they be currently open or not. 
Moreover, this technique avoids also conflicts with the keys already used by the LiteratureMY 
system. However, be warned, please adhere to the usage rules as described above in the 
yellow box. 

Be warned: If you violate any of above rules you risk that incorrect main keys are 
assigned while adding new records! 

In case of difficulties consult also Appendix A7 «Troubleshooting hints». 

                                                 
64 MY will actually be translated to your initials as defined by shell variable LITUSER, e.g. DumpOfCodesAF. 
The value of LITUSER is assigned automatically as sourced from file ~/bin/LITMYPath.txt (provided with 
distribution of package EndNote SE Add Ons…). 
65 as defined by shell variable LITMY, e.g “/Volumes/HD/uaf/Data Bases/AFs Lit” (may contain blanks). The 
value of LITUSER is assigned automatically as sourced from file ~/bin/LITMYPath.txt (provided with 
distribution of package EndNote SE Add Ons…). 
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5) Set your AutoFile preferences in BibDesk similar to this:   

 
 where the folder in which you store your pdf’s needs to be specified once using 

button  Choose…. You need also to use the button to enter the 
Format String for local files similar to this: 

 
 Note, if your MY is different from ‘AF’, you need also to insert into the format string 

your actual MY before the extension ‘%e’. Say your MY is ‘DG’, then the format 
string becomes: “%f{Cite Key}%n0dg%e”. Otherwise don’t change the format or 
you risk that your pdf’s won’t be accessible from within EndNoteMY or 
LiteratureMY.  

 Any pdf you drag and drop onto BibDesk’s side pane to the right will then be linked 
to the record, automatically renamed according to the rules, and can even be 
conveniently moved to the specified folder where you keep your pdf’s. Moreover 
opening pdf’s is then not only possible from within BibDesk, but also from within 



Latest Additions Literature September 4, 2009 

34 

EndNote as well as LiteratureMY.66 The renaming and moving of pdf’s (BibDesk 
calls this feature AutoFile) happens automatically if you check the preference “File 
papers automatically”  (recommended67). Having this preference 
off gives you more control and you can easily accomplish the renaming and moving 
of the files later by issuing menu command “Publication -> AutoFile Linked 
Files…”. Experiment and choose this preference to your taste. 

6) Set your Default Fields preferences in BibDesk to this:  

 
 I highly recommend to at least check field Doi for optimal cooperation between 

BibDesk and LiteratureMY, but you may wish to customize BibDesk further once 
you learned better how to use it. 

 To fully support the reference type Map, you should also define the non-standard 
BibTeX field Cartographer as being of type Person. Click on the  symbol and 
enter following specifications: 

 

                                                 
66 It may be preferable to specify the same shortcut for opening pdf’s in all applications as EndNote provides, 
i.e. Command-Option-P by defining this very same keyboard shortcut in the System Preferences pane Keyboard 
& Mouse for FileMaker as well as BibDesk. 
67 The reason is that you may link to pdf’s stored in temporary directories that get occasionally cleared, e.g. for 
sure during a system restart. Thus it is generally safer to immediately move pdf’s to where they should be. 
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 I highly recommend to automatically convert added files and URLs, i.e. to have 
“Automatically convert File and URL fields” checked. This means that pdf’s and 
URLs are shown in the right side pane as active thumbnails upon entering BibDesk , 
e.g. as a result from a transfer from LiteratureMY to BibDesk or other means of 
importing records. Concerning files, I see no need to keep upon conversion the 
rather confusingly named field Local-Url, which is used during imports to specify 
path and names denoting local pdf’s. However, I personally prefer to keep the old-
fashioned fields Url and Doi intact upon conversions. But you may prefer to check 
even that option “Remove converted Remote URL fields”. As a result any possibly 
present field Url and Doi will not only be converted and appear on right side pane, 
but those fields are also removed as redundant from the record. Thus, set it to your 
liking (more can also be learned in the next section «A short BibDesk tutorial»). 

Optionally you can also customize BibDesk  to support EndNote  citations: 
7) (optional) Set your Template Files preferences in BibDesk to this:  

 
 after having copied the template68 files CiteEndNoteTemplate.txt and SE_Style.txt 

into folder ‘~/Library/Application Support/BibDesk/Templates/’. As a result you 
may choose menu command "Edit -> Copy As" with the template EndNote Citation 
to get exactly an EndNote conformant temporary citation in your clipboard, which 
you can paste e.g. into a Word document. The standard Services menu may also 
provide easy access to such a clipboard in applications that support Services.  

 Choosing menu command "Edit -> Copy As" with template SE Style will give you in 
the clipboard a full reference as used in a list of references. For really convenient use 
of this template I have defined keyboard shortcut Ctrl-K (in analogy to EndNote’s 
Cmd-K) for SE Style in the System Preferences pane Keyboard & Mouse for 
FileMaker, following the technique as described in section «New helper scripts». 

                                                 
68 provided with distribution of package EndNote SE Add Ons… 
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8) (optional) Set your Citation Behavior preferences in BibDesk similar to this:  

 
 As a result you may now even drag and drop from BibDesk to Word to get an 

EndNote conformant temporary citation or get it via clipboard by choosing standard 
menu command “Edit -> Copy” (Cmd-C). All very convenient! 
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A8 Correspondence between EndNote, FileMaker, and BibDesk/BibTEX reference types 

The following table may be handy in knowing which EndNote reference type (field Reference 
Type) corresponds to which FileMaker reference type (field Ref_Type) and to which BibDesk 
or BibTEX, respectively, entry type (see also the similar table in section «Exporting to 
BibTEX files», which is sorted by LiteratureMY fields). Yellow highlighted are reference 
types of particular interest. Transfers to watch out for are highlighted in light pink. They 
require some manual editing of the reference types once the transfer is complete, since no 
matching or no unique matching is possible among the three sets of reference types. 
  

# EndNote X192 LiteratureMY‡ BibDesk93 (BibTEX94) 
 Aggregated Database - - 
 Ancient Text - - 
 Artwork - - 
 Audiovisual Material - - 
 Bill - - 
 Blog - - 
6 Book Book book 95 
5 Book Section In Book inbook 96 
 Case - - 
 Catalog - - 
 Chart or Table - - 
 Classical Work - - 
9 Computer Program Tech Report manual 
47 Conference Paper In Proceedings inproceedings, 

conference 97 
10 Conference Proceedings Proceedings proceedings 
 Dictionary - glossdef 
28 Edited Book Edited Book book 98 
43 Electronic Article Electronic Article 99 electronic 

                                                 
92 The table actually also lists reference types contained in EndNote X2 and EndNote X3. Those are highlighted 
with a light brown. 
93 BibDesk is an open source application available from http://bibdesk.sourceforge.net/  
94 BibTEX standard reference types (entry types) are listed in bold. Other reference listed in this column are 
extensions to the BibTEX standard as offered by BibDesk (as of this writing Version 1.3.21 (1525)) 
95 In this case a BibTEX field author instead of editor should be present in the record 
96 BibTEX‘s entry type inbook as well as LiteratureMY’s reference type In Book are both restricted to a book 
authored by the same author(s) as the cited section. Don’t confound this type with BibTEX‘s entry type 
incollection or LiteratureMY’s reference type In Edited Book, which are used for a contribution of authors in an 
edited book. Unfortunately EndNote does not differentiate these two cases and users often confound them. Even 
BibTEX users may sometimes map incollection to EndNote’s Book Section (e.g. BibDesk Version 1.3.21 (1525) 
EndNote XML export), while our system always keeps the two cases clearly separate by mapping incollection 
exclusively to the SE custom EndNote reference type In Edited Book (Unused 1). To avoid data loss in case of 
this mistake, however, SE custom EndNote reference type In Book does tolerate a field Editor. 
97 BibTEX‘s entry type conference is a synonym to inproceedings, not proceedings, and its purpose is outdated 
(http://nwalsh.com/tex/texhelp/bibtx-11.html). Our system does not use it and I recommend against its use. 
98 In this case a BibTEX field editor instead of author should be present in the record 
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 Electronic Book - - 
 Encyclopedia - - 
 Equation - - 
 Figure - - 
 Film or Broadcast - - 
13 Generic Miscellaneous misc 
13 Generic Booklet booklet 
 Government Document - - 
 Grant - - 
 Hearing - - 
17 Journal Article Journal Article article 
 Legal Rule or Regulation - - 
 Magazine Article - - 
 Manuscript - - 
20 Map Map misc 100 
23 Newspaper Article Newspaper Article article 
 Online Database - url 
 Online Multimedia - url 
24 Pamphlet Booklet101 booklet 
25 Patent Custom102 misc 
26 Personal Communication -103 - 
27 Report Report techreport 
 Serial - periodical 
 Standard - - 
 Statute - - 
32 Thesis Thesis masterthesis, 

phdthesis, jurthesis 
34 Unpublished Work Unpublished unpublished 
12 Web Page Web Page104 webpage 
40 In Edited Book† (Unused 1) In Edited Book incollection 
41 Edited Report† (Unused 2) Edited Report report 

                                                 
99 Newly supported reference type. Fields are to be treated the same as an ordinary Journal Article. This new 
reference type offers the following advantage: It allows you to distinguish two types of journal articles in the 
used Output Style of EndNote used to generate the list of references: For instance Journal Article’s without a 
DOI and Electronic Article’s with a DOI. 
100 BibTEX entry type misc encodes reference type Map (EndNote, LiteratureMY) if the record contains field 
Cartographer in place of standard BibTEX field author (BibDesk later than Version 1.3.21 (1525)). 
101 EndNote X1 recognizes not yet type Pamphlet and therefore any transfer between LiteratureMY and EndNote 
X1 requires a manual reassignment of the reference type after the transfer has been completed (here not 
highlighted in light red). Note, as of this writing EndNote X2 has serious deficiencies relative to EndNote X1 and 
and I recommend strongly against its use, and EndNote X3 is not yet available for the Mac OS X platform. 
102 Use reference type Custom in EndNote as a custom style you can customize freely to accommodate special 
needs of your publisher. 
103 Actually this reference type is tolerated and its transfer is fully supported between EndNote and 
LiteratureMY. However, it is recommended to enter a personal communication only within EndNote 
bibliographies and to avoid burdening LiteratureMY from storing records of such rather ephemeral nature. 
104 Newly supported reference type. The LiteratureMY field URL is mandatory and the LiteratureMY field No. 
may contain the access date. In case that field No. is empty, the LiteratureMY field Entry_Date is used as the 
access date. 
† Edited reference type  
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42 Edited Articles† (Unused 3) Edited Articles proceedings 
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A9 Correspondence between EndNote, FileMaker, and BibDesk/BibTEX fields 

The following table may be handy in knowing which EndNote field corresponds to which 
field in FileMaker and BibDesk. The red highlighted field is the main key that identifies each 
record. Yellow highlighted are field names, which are particularly important to remember 
well or which are not obvious, yet commonly used. Teal highlighted are fields that are new in 
EndNote X2 and EndNote X3. 

 
# Field Name in 

EndNote X1 105 
Field Name in 
LiteratureMY ‡ 

Field Name in 
BibDesk 106 

1 Reference Type Ref_Type entry type 107 
2 Author Authors author, 

Cartographer 108 
3 Year Year year 
4 Title Title title 
5 Secondary Author Editors editor 109 
6 Secondary Title JOrPubl journal, booktitle 
7 Place Published City address 
8 Publisher Publisher publisher, 

organization, 
institution, school, 
howpublished 

9 Volume Vol volume 
10 Number of Volumes Microfiche Custom5 * 
11 Number No. number 
12 Pages pp pages 
13 Section - - 
14 Tertiary Author SeriesEditor Custom5 * 
15 Tertiary Title SeriesTitle series 
16 Edition Edition edition 
17 Date PlaceDate month 
18 Type of Work TypeOfWork type 
19 Subsidiary Author - - 
20 Short Title - - 
21 Alternate Title 110 - - 
22 ISBN/ISSN ISBN Isbn 

                                                 
105 Names as used in the reference type Generic of EndNote X1 
‡ This correspondence is valid as of this writing for EndNote X1 (Bld 2377) and LiteratureMY v3.0r2 (January 
2008) and later versions 
106 BibDesk supports any field names, but listed here are only those that are used by LiteratureMY when 
exporting to BibTEX  
107 Has actually no special field name and is the first identifier used in the record 
108 To encode reference type Map (EndNote, LiteratureMY) you can use in BibDesk (later than Version 1.3.21 
(1525)) the field Cartographer in place of standard BibTEX field author. 
109 BibTEX entry type book encodes the reference type Book or Edited Book (EndNote, LiteratureMY), 
respectively, depending whether the record contains a field author or editor. 
* Field Custom5 is reserved for internal use while transferring records back and forth between BibDesk and 
LiteratureMY via EndNote. 
110 May be used for internal purposes in case of reference type Generic 
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23 DOI DOI Doi 111 
24 Original Publication - - 
25 Reprint Edition - - 
26 Reviewed Item Owners Custom5 * 
27 Custom 1 Users Custom5 * 
28 Custom 2 Ref_Status Custom5 * 
29 Custom 3 Entry Date Custom5 * 
30 Custom 4 Modified Custom5 * 
31 Custom 5 - Custom5 * 
32 Custom 6 Custom 6 Custom5 * 
33 Custom 7 Custom_7 Custom5 * 
34 Accession Number - - 
35 Call Number Bibl. Custom5 * 
36 Label SysEcolCode cite key 
37 Keywords Keywords keywords 
38 Abstract Summary abstract 
39 Notes Project, InUseFor, 

StoragePlace, 
InCrdIndex 112 

note 

40 Research Notes Comments 113 annote 
41 URL URL Url   

(Bdsk-Url-1, -2 …) 114 
42 File Attachments pdf_pathfilename_URL Local-url  

(Bdsk-File-1 …) 115 
43 Author Address - - 
44 Figure - - 
45 Caption - - 
46 Access Date - - 
47 Last Modified Date116 - - 

                                                 
111 Since the field Doi may also represent an URL, e.g. http://dx.doi.org/<DOI>, or hold alternatively an URL, 
this field is also involved in BibDesk’s conversions of file and URL fields. Thus, the presence of this field 
depends on the mode of conversion: Conversion with keeping so-called local URLs preserves this field, a 
conversion without keeping it will remove it and replace it by fields named Bdsk-Url-1, Bdsk-Url-2 etc. 
Transferring a DOI URL stored in such a field Bdsk-Url-1 to LiteratureMY will reconstruct the content of the 
field DOI. 
112 For legacy reasons all these fields are stored in BibTEX field note using a specific keyword 
113 When exporting from LiteratureMY to EndNote, field Comments ends up in EndNote’s field Research Notes. 
When exporting from LiteratureMY to BibTEX, field Comments ends up in BibDesks’ field annote. When 
importing into LiteratureMY, EndNote’s field Notes as well as Research Notes (or BibTEX‘s note and annote, 
respectively) are both merged into LiteratureMY’s field Comments. 
114 URLs of web sites are here entered as e.g. “http://www.sysecol.ethz.ch“. However, when using BibDesk, the 
presence of these fields depends on the mode of conversion of file and URL fields: Conversion with keeping so-
called local URLs preserves this field, a conversion without keeping it will remove it and replace it by fields 
named Bdsk-Url-1, Bdsk-Url-2 etc. BibDesk lists these fields under the heading Remote URLs. 
115 Links to pdfs are here entered as so-called file URLs, e.g. 
file://localhost/Volumes/HD/uaf/Data%20Bases/AFEles/afEles_AFCD100/F/Fi103.pdf. Normally BibDesk 
(1.3.21 (1525)) automatically converts this to the internally used file linking scheme, which can also safely be 
exported to EndNote’s File Attachments and from there to LiteratureMY. Once converted by BibDesk, this field 
is normally removed and replaced by fields Bdsk-File-1, Bdsk-File-2 etc., BibDesk lists these fields under the 
heading Local Files.  
116 Replaced by new field ‘Custom 8’ in EndNote X2 and EndNote X3 and becomes field ‘Last Updated’ at 
position 54 
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48 Translated Author - - 
49 Translated Title - - 
50 Name of Database - - 
51 Database Provider - - 
52 Language - - 
53 C Added to Library - - 
54 C Last Updated117 - - 

                                                 
C New field only available in EndNote X2 and EndNote X3 
117 Former field Last Modified Date as used in EndNote X1 
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A11 Importing: EndNote  tags and corresponding fields (from EndNote  manual) 

The table below shows the tags recognized in the EndNote  Import format of EndNote X1, and 
the corresponding EndNote  field into which each tagged item is imported for the Generic 
reference type. For other reference types, many fields may be mapped to the Notes field 
(since a limited number of fields are included in each reference type). The Figure field is not 
included for importing. 
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However this list as shown in EndNote manuals is incomplete. E.g. the field Alternate Title is 
not listed, which we encode with tag %Z, since we use %O according to our tradition for field 
Notes. 

See also http://colab.mpdl.mpg.de/mediawiki/PubMan Func Spec Endnote Mapping  
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